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Introduccion:
La intencién del manual es proporcionar al usuario los conceptos bdsicos de la creacion y
manipulacién de g-codes.

En este manual se explican los pardmetros esenciales del programa Slic3r, asi como trucos y
consejos que pueden hacer que una impresidon reluzca o que falle. EIl dominio del software
Slic3r es importante, ya que de él dependen la mayoria de pardametros de nuestra maquina y
extrusor, asi como las capacidades de la misma. Aqui se podran definir alturas de capa,
velocidades y demds pardmetros de nuestra futura pieza, y de él dependerdn también los
tiempos de produccién y el consumo de material.

La mayoria de los parametros introducidos en este manual son meramente orientativos, cada
parametro puede diferir de la maquina, aun siendo una mismo modelo o base. Asi,
recomendamos ajustar los pardmetros en entornos no muy alejados de los orientativos, pero
no cefiirse a los mismos.

Asimismo, RepRapBCN no se hace responsable de posibles dafios causados por mala
configuraciéon del programa o por algin dato del manual.

RepRapBCN cede este manual a libre distribucion, siempre y cuando a partil de él no se genere
beneficid alguno. El proyecto de reprap, asi como su informacién, son abiertos 100% y se
pueden distribuir. También estamos abiertos a sugerencias y mejoras, asi como posibles
errores. Estaremos encantados de recibir mejoras, y para ello, el usuario dispone del correo
info@reprapbcn.com para mostrar sus comentarios.

Creado por: Albert Campos Merola
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Descarga e instalacion:
En esta parte mostraremos como descargar e instalar el programa.

1. Paraello abriremos el navegador de internet, y nos dirigiremos hacia la pagina web
siguiente: http://slic3r.org/

2. Alaedicion de este manual, la versidén mas reciente es la 0.9.7. Al entrar en la web
encontramos

.
S l l C3 r Home About Download Support Blog Donate

G-code generator for 3D printers

Slic3r 0.9.7 is out!

This new release contains many bugfixes and improvements. A new setting
for gaps fill speed was introduced to reduce shaking. Recent versions also
introduced the ability to fill narrow gaps and dual (multi!) extruder
support.

v

Free. For MacOS X, Windows and Linux

Latest blog article: 3D printing - present and future of Slic3r »
Clicaremos en la pestafia de” download now”.

L]
S ll C3 r Home About Download Support Blog Donate

G-code generator for 3D printers

Download

Using precompiled packages (recommended)
Click on your operating system to download the precompiled packages

e @ A

Mac OS X Windows Linux

Release notes:

Running from the source code

Seleccionamos el sistema operativo y descargamos el paquete necesario para hacer
funcionar el programa tanto en 32bit (version x86) como 64bit(x64).

3. Empezara la descarga del paquete seleccionado en un archivo comprimido (.rar) Al
finalizar dicha descarga descomprimiremos el contenido del archivo al lugar donde
deseemos tener el programa(p.ej el escritorio).



4. Slic3r es un programa autoejecutable (.exe) y no requiere de instalacion previa antes

de su utilizacidon. Una vez descomprimido el contenido en el escritorio,

seleccionaremos el archivo Slic3r.exe

13
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-

5.

Compartir con =

Nombre

bin

| cpfworkrt

dil

lib

res
9 slicar
@ slic3r-console

La primera vez que ejecutemos el software nos aparecerd e

*

Grabar

Nueva carpeta

Fecha de medifica...

2012 17:59

012 18:00

012 18:00

/2012 18:00
/2012 18:00
23/11/2012 17:59

23/11/201217:58

Tipo

Carpeta de archivos
Carpeta de archivos
Carpeta de archivos
Carpeta de arc
Carpeta de archivos
Aplicacian

Aplicacian

Tamafio

576 KB
576 KB

Ill

v | 43 | | Buscar

configuration wizard”.

Llegados a este punto pasamos al siguiente apartado del manual.



Configuracion inicial:

1.

2.

Nos aparece la primera imagen del menu inicial de configuracion.
ANota: Si no aparece el mend inicial de configuracion, en Slic3r ir al menu
desplegable de Help/Configuration Wizard
Configuration Wizard |
Welcome to the Slic3r Configuration Wizard
2 Welcome Hello, welcome to Slic3r! This wizard helps you with the initial configuration; just
a few settings and you will be ready to print.
To import an existing configuration instead, cancel this wizard and use the Open
Config menu item found in the File menu.
To continue, click Mext,
< Bacl Mext > ] | Cancel
Pulsamos en “Next”.
Configuration Wizard @
Firmware Type
& Welcome Choose the type of firmware used by your printer, then click Mext.
» Firmware Type
G-code flavor RepRap (Marlin/Sprinter] =

Extrusion Temp

Bed Temperature

Finish

< Back | [ Mext = ] | Cancel

En esta pestafa seleccionaremos el firmware que controla nuestra maquina.

ANota: Por defecto las maquinas de RepRapBCN, tanto la PRUSA 3D como
la BCN 3D llevan en los manuales como cargar el firmware Marlin.




Pulsamos en “Next”.

3. En esta pestafia aparece el tamaino de nuestra base. Introducimos las dimensiones de
la base en mm. Cuando tengamos las medidas introducidas, pulsamos en Next

Configuration Wizard
Bed Size
® Welcome Enter the size of your printers bed, then click Mext.
® Firmware Type
» Bed Size
Bed size: w200 w200 mm
| < Back ‘ [ Mext » ] | Cancel

ANota: Por defecto las maquinas de RepRapBCN, tanto la PRUSA 3D como
la BCN 3D utilizan diferentes bases pero del mismo tamafio en x,y. Por defecto
es de 200x200mm para ambas maquinas.

4. En esta pestana aparece el parametro de diametro de la boquilla. Se debe introducir el
diametro de la boquilla en mm. Cuando tengamos el tamafio introducido, pulsamos

Next.
Configuration Wizard @
Nozzle Diameter
® Welcome Enter the diameter of your printers hot end nozzle, then click Next.

@ Firmware Type

® Bed Size

- Mozzle diameter: 0.5
+ Mozzle Diameter pzzie dlameEter mm
Filarnent Diameter
Extrusion Temperature
Bed Temperature
| < Back | [ Mext > ] | Cancel |

ANota: El hotend V5 del Greg’s Extruder de RepRapBCN es de 0,5mm de
didmetro. Para més diametros, mirar anexo 1.




En este apartado debemos introducir el didmetro del hilo. Se recomienda medir el

diametro del mismo con un pie de rey para verificar el didmetro correctamente.

Posteriormente pulsamos en Next.

ATruco: Hemos descubierto que en nuestro material, la media del grosor
del material de 3mm es de 2,93mm de didmetro. Si se esta utilizando material
de RepRapBCN se puede introducir 2,93mm sin ningln miedo.

Configuration Wizard
Filament Diameter
8 Welcome Enter the diameter of your filament, then click Next.
& Firmware Type
» EedSbe Good precision is required, so use a caliper and do multiple measurements along

the filament, then compute the average,

® Nozzle Diameter
2 Filament Diameter

Extrusion Temperature Diameter:

mm

| < Back | l Mext > ] | Cancel |

En el apartado que viene a continuacién se debe introducir la temperatura de la

boquilla. Este pardmetro puede diferir del material que utilizamos. A continuacién una

tabla resumen con los valores orientativos.

Material Temperatura 2C
Pla no translucido 190-195
Pla translucido 165
ABS 210-230
Coenfiguration Wizard @
Extrusion Temperature
® Welcome Enter the temperature needed for extruding your filament, then click Nesxt,

@ Firmware Type

® Bed Size A rule of thumb is 160 to 230 °C for PLA, and 215 to 250 *C for ABS.

® Nozzle Diameter
e Fil t Diamet
| Other layers:
' Extrusion Temperature

Bed Temperature

Una vez introducidos, pulsamos en Next.

200 = *C
Extruder temperature for layers after the
ternperature control commands in the ¢
| < Back | [ MNext = l | Cancel




7. Enlaventana siguiente aparece la configuracion de la temperatura de la base.

A continuacidn mostramos una tabla resumen con los valores orientativos

Material

Temperatura 2C

Pla no translucido

55-60 con kapton, 70 sin kapton

Pla translucido

55-60 con kapton, 70 sin kapton

ABS

90 con kapton, 110 sin kapton

Configuration Wizard

® Welcome

@ Firmware Type

@ Bed Size

® Nozzle Diameter

@ Filament Diameter

@ Extrusion Termnperature

o Bed Temperature

Bed Temperature

Enter the bed temperature needed for getting your filament to stick to your
heated bed, then click Mext.

Acrule of thumb is 60 *C for PLA and 110 °C for ABS.

Other layers: 55 =

-

Al finalizar pulsamos en Next.

Hemos finalizado la configuracién basica del programa, ahora es necesario cambiar algunos

parametros extras para poder empezar a imprimir. Estos se comentan en el siguiente apartado

de Configuracion Avanzada.




Configuracion Avanzada:

El programa Slic3r se estructura en 4 pestafias con bastantes opciones en cada una de ellas. A

partir de este momento el manual se estructura en 4 partes, cada una para cada pestana.

% slic3r [E=8(Een "=
File Plater  Window Help
Plater |PrintSettir|gs Filament Settings PrinterSettingslI
Muore Less 45° 45° Rotate... Scale.. ||«=Spli
MName Copies Sce
Plater:
% siex oo s
File Plater Window Help
Plater |Print5ettings Filament Settings | Printer Settings
More Less 45° 45° Rotate... Scale... ||=28pli
MName Copies Seg
Drag your objects here
i 1n | 3
“gAdd... Autoarrange Export G-code...
Delete Delete All Export 5TL...
Print settings: | - default - - Filament:l-default- v] Printer:[-default- -

Version 0.9.7 - Remember to check for updates at http://slic3r.org/

Tabla de funciones:

Nombre Funcidn

Add... Mediante este botén podemos afiadir nuevos
.stl que queremos imprimir.

Delete Mediante este botdn borramos los .stl
afiadidos anteriormente.

Autoarrange Con el botdn autoarrange nos posiciona
correctamente o reparte varios .stl anadidos
anteriormente uniformemente por la
plataforma

Delete All Borra todos los .slt afiadidos anteriormente.

Export g-code

Nos genera el g-code con los pardmetros
introducidos en ese momento y nos pide
donde guardar dicho .gcode

Export .STL

Exporta la plataforma con uno o varios .stl
afadidos a un solo archivo .stl y nos pide
donde guardarlo.




Print settings(desplegable)

Nos permite seleccionar un archivo de
configuracién solo para los parametros de la
pestana print settings. Este archivo tiene que
estar cargado antes desde File-Load Config.

Filament (desplegable)

Nos permite seleccionar un archivo de
configuracién solo para los parametros de la
pestafia Filament settings. Este archivo tiene
gue estar cargado antes desde File-Load
Config.

Printer (desplegable)

Nos permite seleccionar un archivo de
configuracién solo para los parametros de la
pestafia Printer Settings. Este archivo tiene
gue estar cargado antes desde File-Load
Config.

More

Cuando tenemos un archivo .stl cargado, la
funcién more permite duplicar dicho archivo
para obtener mas piezas del mismo .stl

Less

Cuando tenemos un archivo .stl cargado, la
funcién Less permite eliminar copias de este
mismo para obtener menos piezas del
mismo. Previamente se tiene que haber
utilizado la funcién More.

+-45¢

Nos permite rotar de forma positiva o
negativa el .stl en el eje de laZ en una
rotacién de 45 grados centigrados positivos o
negativos.

Rotate

Nos permite rotar de forma positiva o
negativa el .stl en el eje de laZ en una
rotacion de X grados centigrados positivos o
negativos. Nos solicitara la cantidad X que
deseemos.

Scale

Nos permite escalar piezas para obtener
piezas mas grandes o mas pequefias. Nos
pedird el % de escalado que deseemos. 120%
hara la pieza un 20% mas grande, 80% hara la
pieza un 20% mas pequeia.

Split

Esta funcién nos permite dividir .stl




Print settings:

% Slic3r EI@

File Plater Window Help
Plater | Print Settings |Fi|ament Settings | Printer Settings

- default - v] Layer height

@l Layers and perimeters Layer height: 0.4 mm
Infill First layer height: 100% mm or %
) Speed
Iifl skirt and b”m_ Vertical shells
Lol Support matenal
| Motes Perimeters (minimum): 3 =
& Cutput options
I Multiple Extruders Randomize starting points:
7 Advanced 5 te ext - .
. enerate extra perimeters when
needed:

Horizontal shells

*

Solid layers: Top: 3 = Bottorn: 3 =

a4 (L I

Loaded C\Users\CASA\Desktophciutat.5TL

Layers and perimeters:

Nombre del parametro Funcién y valor éptimo

Layer height: Este pardmetro nos configura la altura de capa. A mayor altura
de capa, menos tiempo y menos gasto de material, pero
menos resolucion. Para el PLA de 3mm se recomienda utilizar
alturas de capa que van desde los 0,25mm a los 0,4mm.Para el
PLA 1,75mm se pueden reducir un 20% estas alturas.

En ABS se puede llegar a reducir la altura de capa a 0,15mm o
inferior. Lo recomendable es entre 0,15mm i 0,3mm. No se
recomienda trabajar con ABS a 0,4mm, dado que es mucha
altura para este tipo de material.

First layer height: Este pardmetro configura la altura de la primera capa de la
impresién. Se expresa en % o en mm. Normalmente se
recomienda que la primera capa sea inferior en altura, asi se
asegura una mejor adhesion a ella. Por defecto para uso
normal se puede dejar en 100% o se puede introducir entre un
90%-100%

Perimeters(minimum): En este apartado se configura el nimero de perimetros que ha
de tener la pieza. Hay que tener en cuenta que Slic3r modifica
este nimero a mas perimetros si detecta que hacer infill en
algunas zonas es dificil. Por defecto se puede dejar
perfectamente a 3 perimetros. Si se desea un poco mas de
estructura externa de la pieza se puede aumentar a 4.




Randomize starting points:

Esta opcidn obliga a Slic3r a empezar cada capa en un lado o
posicién diferente de la pieza. Asi se elimina el exceso de
rebaba si siempre se empieza en el mismo punto cada capa.
Se recomienda su uso.

Generate extra perimeters
when needed:

Esta opcidn permite a Slic3r crear mas perimetros en espacios
donde hacer relleno o infill es complicado. Se recomienda su
uso

Solid Layers(Top/Bottom)

Aqui seleccionamos el nUmero de capas solidas que queremos
gue nuestra pieza tenga. Si por ejemplo escogemos 3/3,
nuestra pieza tendra al inicio 3 capas solidas i por la parte
superior 3 capas solidas. La funcion de estas capas solidas es
dar una base y acabado solido y duro. Si se seleccionan mas
capas solidas se gastara mas material pero nuestra pieza
tendrd mas robustez y dureza cuando trabaje por las capas
inferior y superior.

Infill:

Infill tiene su traduccion directa al castellano como “relleno”. En este apartado se trabajan

todos los parametros del relleno de las piezas.

& Slic3r
File Plater Window Help

[ ][ E ] ]

|- default - v||§|
@ Layers and perimeters
infill
=) Speed

[ Skirt and brim
L2l Support material
| Motes
= Output options
| Multiple Extruders
7 Advanced

Infill

Fill density: 0.4
Fill pattern: |recti|ir1ear ‘|
Top/bottom fill pattern: |recti|ir1ear ‘|
Advanced
Infill every: 1 < layers
Solid infill every: 0 < layers
Fill angle: 45 = &

T0 mm®*

Selid infill threshold area:

Only retract when crossing
perimeters:

Loaded C:\Users\CASA\Desktop\ciutat.5TL

Nombre del parametro

Funcidn y valor éptimo

Fill density:

En este parametro tenemos que introducir el % de relleno que
deseamos. Para piezas meramente decorativas se puede optar
por un 40%(0.4). Para piezas con resistencia mecanica se
recomienda un 70% o mas(0.6)

Se recomienda trabajar alrededor del 60% para la mayoria de
piezas. Hay que tener en cuenta que a menor porcentaje de
infill menos material se consumird y mas rapidaira la
construccion, a cambio obtendremos menos resistencia y piezas
mas huecas.




A mas % de relleno, mas material se consume y mas lenta va la
construccion, a cambio obtenemos una pieza mucho mas solida.
Datos curiosos: Para hacer piezas completamente huecas
utilizaremos un infill del 0%, y para obtener piezas solidas 100%.

Fill pattern:

Aqui se configura el patrdn de relleno con el que se desea
rellenar toda la pieza a excepcidn de la capa superior e inferior.
Tenemos diferentes maneras de rellenar segin la geometria de
nuestra pieza. Se recomiendan los infill rectilineo para piezas
normales y concéntrico para geometrias con circulos o
circulares.

Top/bottom fill patern:

Aqui se configura el patrdn de relleno con el que se desea
rellenar la capa superior e inferior.

Tenemos diferentes maneras de rellenar segun la geometria de
nuestra pieza. Se recomiendan los infill rectilineo para piezas
normales y concéntrico para geometrias con circulos o
circulares.

Infill every:

Este pardmetro nos define cada cuantas capas es necesario
hacer infill. Si seleccionamos 2 tendremos capas de relleno cada
2 capas. Se recomienda altamente el uso de 1 para este
pardmetro, es decir que cada capa genere relleno.

Solid infill every:

Este parametro define cada cuantas capas se hace un relleno
solido. Se recomienda un O para este parametro si se buscan
piezas con resistencia normal o media, y un valor diferente si se
desea una resistencia extra. Hay que tener en cuenta que una
capa solida consume mas material y tiempo que una pieza
normal. Si introducimos un 5, cada 5 capas tendremos una
solida, tardara un poco mas y consumira mas material, pero
tendremos mas resistencia.

Fill angle:

Aqui podemos configurar el angulo con el que deseamos
obtener el infill. Si introducimos un 45, nuestro patron de
relleno trazard las lineas a 452. Se puede introducir casi
cualquier valor, pero 452 es dptimo para la programacion del
software.

Solid infill threshold area:

Este pardmetro obliga a Slic3r a generar infill solido para aéreas
menores del valor especificado. Se recomienda el valor por
defecto (70).

Only retract when crossing
perimeters:

Esta funcion, si esta activada, hace la funcidon “retract” del
extrusor solo en el momento que dos perimetros se cruzan
entre ellos. Por defecto y su valor éptimo es desactivado.




Speed:

En este apartado se tratan las velocidades de impresion de todas las partes caracteristicas de

una pieza.

@ Slic3r
File Plater Window Help

=N )

|P|ater | Print Settings

Filament Settings I Printer Settings

|- default -

I8

Speed for print moves

@l Layers and perimeters
o Infill

€] speed|
[Z5] Skirt and brim

ﬁ'_-‘ Support material

| Motes

= COutput options

I Multiple Extruders
7 Advanced

Perimeters: 30 mm,'s
Small perimeters: 30 mm,'s or %
External perimeters: 100% mm,'s or %
Infill: 60 mrmy's
Solid infill: 60 mm,'s or %
Top solid infill: 50 mm,'s or %
Support material: 60 mm,'s
Bridges: 60 mm,’s

Gap fill: 20 mmy's
Speed for nen-print moves

Travel: 130 s
Madifiers

First layer speed: 30% mm/s or %

Loaded C:\Users\ CASA\Desktophciutat.5TL

Nombre del pardmetro:

Funcion y valor éptimo:

Perimeters:

Aqui se configura la velocidad de impresién de los perimetros.
Para impresiones con acabados buenos se recomiendan
velocidades de perimetros alrededor de los 40mm/s.

Se puede llegar de forma estable a velocidades de 70mm/s .
Para pruebas de velocidad las maquinas tienen el limite en los
250mm/s

Small perimeters:

Este pardmetro solo afecta a perimetros con radios inferiores a
6,5mm. Para estos radios se escogen velocidades mas lentas que
los perimetros normales. Asi se pueden trazar de forma correcta.
De no ser asi estos perimetros nunca quedarian bien definidos.
Se recomiendan velocidades de alrededor de un 20% mas lentas
gue para los perimetros estandar. Se pueden expresar en %(seria
optimo un 80%) o en mm/s que se tiene que calcular.

Si se observa que los perimetros pequefios no salen
correctamente, reducir la velocidad de los mismos.

External perimeters:

Este pardmetro solo afecta a los perimetros mas externos de la
pieza, es decir, los que nosotros vemos. Se puede modificar dicha
velocidad para hacer que vaya mas lento y que su acabado visual
sea mejor. Se recomienda de un 90% a un 100%




Infill:

Aqui se determina la velocidad de relleno. Para piezas
convencionales sin geometrias raras se recomienda un 150% de la
velocidad de los perimetros. Para piezas raras o complejas,
introducir un 120% o 130% de la velocidad de los perimetros. Se
tiene que introducir en mm/s

Solid Infill: Es la velocidad del infill de las capas solidas. Se recomienda dejar
este valor al mismo que el infill normal.
Top solid infill: Este pardmetro hace referencia a la velocidad del infill de la capa

superior. Se acostumbra a reducir el valor de la velocidad para
obtener un mejor acabado visual de la misma. Se recomienda
poner un 10% o un 20% menos que la velocidad del solid infill.

Support material:

Velocidad a la que se imprimen las estructuras del material de
soporte. Se puede dejar el valor dptimo, y si se observa que al
realizar las estructuras no son dptimas, reducir la velocidad a
40mm/s o 50mm/s.

Bridges:

La velocidad con la que se fabrican los puentes. El software slic3r
interpreta los puentes como partes donde debe cerrar o unir dos
partes de material separadas por un trozo al aire. Se acostumbra
a realizar los puentes a una velocidad rapida para eliminar la
posible forma de catenaria del material. Con 70mm/s suele
funcionar correctamente. Si se observa falta de material, reducir
la velocidad. Si se observa el material en forma de catenaria,
aumentar la velocidad. Se recomienda que las geometrias no
tengan puentes muy largos ya que si no es inevitable tener la
geometria de catenaria. Si se quiere mejorar el acabado de los
puentes se puede utilizar un ventilador de capa*( Ver manual :
Instalacion de un ventilador de capa)

Gap fill:

Parametro que controla la velocidad de relleno en zonas de
pequefio infill. Este infill caracteristico de las zonas pequefias es
caracteristico por crear un zigzag pequefio. Se recomiendan
valores bajos dado que a altas velocidades de este pardmetro
pueden aparecer vibraciones excesivas y resonancias que nos
harian perder definicion. Entre 10mm/sy 20mm/s

Travel:

El parametro de travel nos define la velocidad en vacio de la
maquina. Este parametro se puede aumentar hasta 150mm/s con
seguridad. Es la velocidad de traslado cuando la maquina no
imprime.

First layer speed:

Este pardmetro nos permite definir un % de velocidad para la
primera capa. Esto nos ayuda a poder hacer que la primera capa
vaya, por ejemplo, un 30% mds lenta que de normal. Al ir la capa
mas lenta, nos aseguramos una adhesion perfecta y un mejor
“primer” acabado. Se recomienda un 50% a un 70%. Si se
observa que la primera capa no se pega correctamente a causa de
la alta velocidad, reducir hasta un 30%.




Skirt and brim:

Cuando empezamos una impresion siempre habremos observado como un caminito o borde

alrededor delimitando la zona de impresién. Este parametro Slic3r lo conoce como Skirt. Esta

delimitacidn se utiliza para la limpieza de la boquilla antes de la impresion. Mas vueltas

siempre mejor, dado que estara mas limpia la boquilla antes de empezar.

En las nuevas funciones de Slic3r también ha aparecido otro parametro especial que nos crea

un borde extra en las piezas para que no se despeguen. Lo llamamos Brim.

% Slic3r
File Plater Window Help

=N ECR =™

Plater | Print Settings | Filament Settings | Printer Settings

|- defautt - ~|

Skirt

@l Layers and perimeters
Infill
=) Speed
I skt and brim|
lal Support material
| Motes
= Output options
I Multiple Extruders
&7 Advanced

Loops:
Distance from object:
Skirt height:

Minimum extrusion length:

Brirm

Brim width: 0 mm
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Nombre del pardmetro:

Funcién y valor éptimo:

Loops:

Este pardmetro nos configura el nimero de vueltas alrededor
delimitando el area de impresidn que se realizaran. Para piezas
que ocupen mas del 50% de la superficie de impresién se
recomiendan 2 vueltas. Para piezas pequefias este nimero debe
aumentarse considerablemente, alrededor de 4 0 5. A mas
vueltas, mds limpia la boquilla.

Distance from object:

Esto nos defina la distancia o separacidn del skirt de las piezas de
la impresion. El valor de 6mm es dptimo si se modifican el
numero de vueltas, aumentandolo para piezas pequefias. Si no se
modifican las vueltas, este nimero ha de aumentarse para piezas
pequeiias hasta 12 mm si la base lo permite.

Skirt height:

Esto nos determina la altura del skirt, expresado en nimero de
capas que tiene que tener en altura. Se recomienda que solo
realice el skirt en la primera capa, asi que dejamos un 1




Minimum extrusién Este pardmetro contrarresta los anteriores. Aqui solo tenemos
Length: gue definir la cantidad de material que consideramos que debe
extruir antes de empezar la pieza en mm y el calcula el numero de
loops que debe hacer. Si estan los anteriores bien configurados,
no se utiliza.

Brim width: Aqui configuraremos que distancia han de tener los bordes extras
del Brim para que obtengamos una adhesion extra. Recordad que
estos mini pies después deben ser retirados. Se recomienda de
1mm a 3mm. Se introduce un O si la pieza es plana y su adhesién
ya es buena de por si.

Suport material:

En este apartado se trata las estructuras de soporte. Con esta estructura ya se pueden fabricar
piezas con voladizos o elementos flotantes. Siempre hay que configurar este parametro
pensando en que posteriormente debe ser retirado mediante un cuter o algin elemento
cortante.
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Nombre del parametro: Funcién y valor 6ptimo:

Generate support material. | Aqui nos permite escoger si realizar soportes o no realizar. Slic3r
crea el mismo y calcula dichos soportes. Si tenemos piezas con
elementos flotantes o voladizos, se recomienda activarlo. Si
Slic3r detecta que la pieza necesita generar soportes, el mismo
los creara. En caso contrario, sera como una impresién normal.




Overhang threshold:

Este parametro nos permite configurar a partir de que angulo
de pared Slic3r creara soportes. Si por ejemplo introducimos un
459, para paredes con inclinacion mayor de 452 no tendran
soportes, i por ejemplo una pared de 302 con respecto a la
horizontal si que se generaran soportes. Con 45 grados es
6ptimo en la mayoria de los casos.

Patern:

Nos permite escoger el patron de andamio para los soportes.
Se recomiendan la nueva generacién de estructura de panel de
abeja si se requieren crear planos flotantes, dado que es mas
resistente, pero mas dificil de retirar. Sino, como valor correcto
como norma general es el rectilineo.

Patern spacing:

Este pardmetro nos permite definir el espaciado del andamio. A
mas espaciado, mas facil de retirar pero menos rigidez y
planitud en la cara que requiere el soporte.

Se recomiendan valores de 3mm a 5mm para piezas normales, y
valores de 2,5mm para piezas pequefias o con mucho detalle.

Patern angle:

En este apartado se define el angulo con el que quiere realizarse
el andamio. En la mayoria de casos no tiene mucho sentido su

modificacidn, asi que se recomienda dejarlo en 02

Notes:
Un apartado para poder apu

ntar notas sobre nuestra configuracién. Es util apuntar para que

esta hecha dicha configuracion o que tiene de diferente.
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. Infill
W) Speed
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| Motes
= Output options
| Multiple Extruders
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Motes

Aqui podemos escribir notas!)
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Output options:

La mayoria de los parametros estan en funcién experimental, y para impresiones cotidianas no

tienen utilidad alguna. Para los curiosos, ahi va su explicacién.
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@l Layers and perimeters
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=) Speed
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=8 Eoh =
Complete individual chjects: [l
Extruder clearance (mm): Radius: 20 Height: 20|
Output file
Verbose G-code: =

Output filename format: [input_filename_base].gcode

Post-processing scripts
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Nombre del parametro:

Funcién y (valor dptimo en fase beta)

Complete individual objects:

Esta opcidn es una novedad que tiene su sentido tedrico pero
poca facilidad de aplicacién. Nos permite realizar impresiones
secuenciales, es decir, imprimir toda una pieza de golpe,
después ir a otra pieza y asi sucesivamente. La idea es de
mejorar la perdida de material si una pieza falla y todas las
demas se ven afectadas. El problema aparece en la segunda o
n piezas siguientes a la primera: las colisiones con el extrusor
en el momento de imprimir la segunda pieza con la primera.

Extruder clearance :

Esto nos permite definir que radio de espacio tiene el extrusor
para trabajar en impresién secuencial sin que tenga impactos
con otras piezas.

Verbose G-code:

Si activamos esta opcidn nos explicara cada paso del g-code
comentado al lado. Esto nos es practico si queremos estudiar
cuales son los pasos de la l6gica del software, ya que si
abrimos el g-code con el notepad sabremos que significa cada
linea.

No se recomienda si se va a imprimir desde tarjeta SD dado
que el archivo g-code ocupara mas espacio de lo normal.




Output filename format: Formato del nombre de los g-code. Por defecto esta
introducido que nos salga con el mismo nombre que el .stl.
Recomiendo no cambiar dicha opcién, dado que es muy
practica.

Post-processing scripts: Totalmente para desarrollo. Nos permite incorporar nuestros
scripts para post-trabajar el gcode.

Multiple Extruders:
Trabajar con multiples cabezales nos puede permitir imprimir en varios colores y con diversos
materiales en una sola pieza.
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En este apartado se nos permite escoger cada extrusor (en caso de utilizar multiples cabezales)
hard cada parte de la pieza.

Advanced:

De esta parte solo se puede decir una cosa, cuidado. Son pardmetros nuevos y la mayoria en
fase bastante verde que no nos aportaran de momento nada nuevo. Solo recomiendo corregir
el parametro de extrusion width- First Layer-y ponerlo de 200% a 100%.




Filament Settings:

Aqui introduciremos los parametros del material que utilizamos. La mayoria se configuran con

el wizard inicial, pero por si no lo has seguido puedes volver a configurarlo por aqui.

Filament:

i Slic3r
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[- default - BIE]
@ Filament

j Cocling

Filament

Diameter 3 mm

Extrusion multiplier: 1

Temperature (°C)

Extruder: First layer: 200 = Other layers: 200
Bed: First layer: 0 = Other layers: 0
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Nombre del parametro:

Funcion y valor éptimo:

Diameter:

Se debe introducir el diametro de nuestro material. Si se observa
gue no saca suficiente material en el momento de la impresion
debemos observar que realmente hemos puesto bien este valor,
y en su defecto corregir o poner un diametro mas pequeno. Para
los materiales de 3mm de RepRapBCN se encuentra como éptimo
2.93mm

Extrusion multiplier:

El ratio de vueltas que da el engranaje pequefio del motor
respecto el grande. Este pardmetro estd definido ya en el
firmware de la maquina, asi que nunca se debe modificar por
Slic3r: Dejar el valor en 1.

Extruder (Temperature)

Nos permite escoger la temperatura de fusién del material y a la
cual fijaremos nuestro extrusor. Se recomienda ir al apartado 6
de Configuracidn inicial de este manual. Para el valor de primera
capa utilizar el mismo valor que en el resto.

Bed(Temperature)

En este apartado se define la temperatura de la base. Para su
valor éptimo mirar punto 7 de configuracidn inicial de este
manual. Se recomienda siempre la 1 capa subir 5 grados del resto
de las capas.




Cooling:

En este apartado se deben incluir los pardametros para el ventilador de capa. Muchos de ellos

seran explicados con mayor detalle en el manual de instalacién de un ventilador de capa.

El ventilador de capa es un ventilador que se situa en el carro del extrusor y dirige aire a la

capay la pieza. Asi se consigue que la pieza se solidifique antes y, al hacer una capa superior,

no haya errores de que la capa inferior no esté dura.

% Slicr
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@ Filament
= P

5 Cooling|

[E= EoB =5

Enable

a

Enable cooling:

Fan settings

Fan speed: Min: 35 = Max: 100

%

Bridges fan speed: 100

Aflln [ alfr

Disable fan for the first: 1 layers

Keep fan always on: =

Cooling thresholds
Enable fan if layer print time is below: 60 = approximate seconds
Slow down if layer print time is below: 15 * approximate seconds

Min print speed: 10 = mm/s
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Debe estar marcado el enable cooling, aunque no tengamos ventilador instalado para que

funcionen los parametros indicados mas abajo.

Asi, de este apartado solo comentar que, independientemente de tener ventilador o no,

podemos configurar:

Nombre del parametro:

Funcion y valor éptimo.

Slow down if layer print is below : Su funcidn es disminuir la velocidad en la

impresion de la capa si el tiempo de
impresién de esta es menor del tiempo
indicado. Esta funcion es muy util si tenemos
piezas muy pequeifias o cupulas. Se
recomienda un valor de 5 segundos.

Min print speed:

Velocidad minima de impresién. Juntamente
con el parametro superior, cuando la capa es
mas rapida que el tiempo indicado, se reduce
a la velocidad indicada aqui. El valor de
10mm/s es correcto.




Printer settings:

Aqui se definen la mayoria de pardmetros caracteristicos de la maquina.

General:

Parametros del tamafio de la base y firmware.

i Slic3r
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(=l General
¢ Custom G-code
| Extruderl

Size and coordinates

Bed size: w200y 200 mm

Print center: w100y 100 mm

Z offset: 0 mm
Firmware

G-code flavor: RepRap (Marlin/Sprinter) =
Use relative E distances:

Capabilities

Extruders: 1
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Nombre del pardmetro:

Funcién y valor éptimo

Bed Size:

Definimos el tamafio de la cama o base. Este pardmetro ya ha sido
definido en el configuration wizard, para las maquinas PRUSA 3D y
BCN 3D es 200x200mm

Print center:

Aqui escogemos donde centraremos la impresién. Por defecto y
como optimo es una impresion centrada en la base, por lo tanto
100x100mm

Z offset

Este pardmetro nos define la altura inicial que tiene la impresion. Si
la maquina esta bien calibrada a 1 decima el extrusor de la base
este parametro tiene que ser 0. Si por ejemplo observamos que la
impresion sale muy levantada de la base, este pardmetro nos
permitird definir un Z origen mas bajo.

G-code flavor:

Seleccionamos nuestro firmware. Para las impresoras de
RepRapBCN es Marlin.

Use relative distances:

Siempre tener la opcion desactivada.

Extruders

Definimos el numero de cabezales que tiene nuestra maquina. Por
defecto sera 1.




Custom G-code:
En esta parte no hay pardmetros propiamente dichos. Aqui se pueden configurar g-codes para
gue se ejecutan al inicio de la impresidon y al final de la misma. Se ha afiadido el cddigo que se

apague el bed al finalizar la impresidon: Simplemente se trata de tener lo mismo que hay en
pantalla.
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File Plater Window Help

| Plater | Print Settmgsl Filament Settmgs| Printer Settings

- default - (modified)  + Start G-code

(=) General G28 ; home all axes L
.2 Custom G-code
[ Extruderl

End G-code

M104 50 ; turn off temperature -
G28 X0 ; home X axis
M&4  ; disable motors

Layer change G-code
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Extruder 1:

Aqui se definen parametros de los extrusores. Como se ha introducido que solo tenemos un

extrusor, solo nos aparecen valores para un solo extrusor.

% Slic3r
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=N |EoR

| Piater | Print Settings | Filament Settings | Printer Settings !

[- default - (modified) ~ ][]

(&=l General
o2 Custom G-code

[ Exiruder

Mozzle diameter: 05 mm

Positien (for multi-extruder printers)

Extruder offset: w0 y: 0 mm

Retraction

Length: 1 mm (zero to disable)
Lift Z: 0 mm

Speed: 30 = mm/fs

Extra length on restart: 0 mm

Minimum travel after retraction: 2 mm

Retraction when tool is disabled (advanced settings for multi-extruder setups)
Length: 3 mm (zero to disable)

Extra length on restart: 0 mm
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Nombre del pardmetro:

Funcién y valor éptimo:

Nozzle diameter:

El didmetro del agujero de nuestra boquilla. Para el Greg's
Extruder, Miniextruder o hotend V5 el agujero es de 0,5mm

Extruder offset:

Solo si tenemos un doble extrusor o mas cabezales. Se tratara con
mas detalle en el futuro manual del doble extrusor.

Length(Retract):

Este pardmetro hace referencia a la cantidad de material que el
extrusor tira hacia atras cuando el mismo pasa de imprimir a dejar
de imprimir y moverse. Para el Greg’s Extruder este parametro es
2mm.

Lift Z:

Aqui introducimos la altura que sube el extrusor cuando cambia de
pieza que esta imprimiendo. Para piezas con una pequefia base o
muy altas o con mucho detalle se recomienda usar 0,3mm. Para
impresiones normales 0,2 0 0,15mm es dptimo.

Speed:

Velocidad a la que el extrusor hace el retract del material. Se
recomienda un valor alto para hacer el vacio de la boquilla rapido y
limpio. Una velocidad entre 30mm/s y 50mm/s es correcta.

Extra Length on restart:

Dejar este pardmetro siempre a 0. Nos indica la cantidad de
material que el extrusor debe tirar de nuevo cuando cambia de
pieza y hace retract. Este parametro no funciona bien y acostumbra
a sacar excesivo material al nuevo inicio. Dejaren 0 .

Minimum travel after
retraction:

Este pardmetro nos indica el recorrido minimo que el extrusor
tiene que hacer para detectar que tiene que hacer todas las
funciones comentadas anteriormente o hacer un retract en
términos técnicos. Si por ejemplo introducimos 5mm, si el extrusor
debe desplazarse 6mm hard retract y si debe desplazarse 4 no hara




nada diferente. Es recomendable situar este parametro entre 5y 7

mm
Length2 Parametro solo utilizado en doble extrusor. Mas detalle en el
futuro manual de doble extrusor.
Extra length2 Parametro solo utilizado en doble extrusor. Mas detalle en el

futuro manual de doble extrusor.

Guardar y cargar configuraciones:
Una vez realizada una configuracidn, estas se pueden guardar para volverlas a utilizar en un
futuro.

e Laforma mas sencilla de hacerlo es dirigiéndonos al menu file-export config.

Ahora la guardamos y le ponemos un nombre que nos sirva para identificarla en un futuroy
nos pueda servir para mas piezas.

e Para cargar una configuracién ya guardada anteriormente, menu file-import config.

Finalizar la creacion del g-code:
Una vez ya definidos todos los parametros, cargado la pieza .stl y ajustado todo lo necesario,
solo nos queda darle en la pestaia plater- export g-code y esperar a la creacion del cédigo.

Consejos:

Cada pieza debe tener su cédigo. Aun asi Slic3r tiene sus limitaciones y sus defectos. Para
piezas superiores a 10Mb podemos tener problemas al hacer el cédigo ya que puede quedar el
programa sin responder. Si se observa que el programa se cierra inesperadamente, o calculay
a la mitad se cierra, seguramente es problema del .stl o su gran tamafio.

Se recomienda trabajar con piezas corregidas con el software netfabb basic y con piezas de
tamafio pequeio.

Aqui finaliza este manual, ahora solo queda imprimir y dejar volar la imaginacién!




